Global Processing and Products
from MERIS Full Resolution Data
for the Coastal Zone

User Consultation Meeting
CC Product Demonstration

21.10.2011
Lisbon
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Agenda

* 9:30 Technical set-up

® 10:00 Lecture and hands-on exercise 1
e LiP, L2R bands and flags and meta data

e VISAT basic visualisation tools: RGB, colour tables, linking, flags,
bitmask manager

* 1115 break
* 11:45 Lecture and hands-on exercise 2

e Lat-lon, attach geocoding, projection, collocation

e Layer manager, bitmask manager; histograms and scatter plots
* 12:30 Lecture and hands-on exercise 3

e Validation example: pins transects, pixel extraction tool, working on
time series of data; in-situ data;

® 13:30 - 14:00 Questions & Answers
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BEAM Installation

* Download 4.9.1
¢ Implement BEAM software and start VISAT

¢ Update with the newest modules
~>Module manager

© File Edit View Analysis Tools Window | Helj
M- (=] 2 Help Topi F1
PSB ZB(e2 QY o
T BEAM Home Page
Access to Data Products
# @ Module Manager...
Check for New Release...

D About VISAT Strg+Alt+ A
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4 Instal £ Update = Uninstall Y Clear Filter category: -
Inctaled odles Avaiabe Modies
‘ Name Version Date Size Action
AATSR Recalibration  [1.2.1 03-Aug-2011 261K o
ASCII Product Reade...[1.1.1 03-Aug-2011 20K B
[ATSR Cloud Stereo M... 0.10 03-Aug-2011 1M :
CHRISProba Atmosp... 1.5.3 03-Aug-2011 140K 3
CHRIS/Proba Atmosp... |1.5.3 03-Aug-2011 93M L4
CHRIS[Proba Cloud S.... |1.5.3 03-Aug-2011 462K
CHRISProba Geomet... |1.5.3 03-Aug-2011 [s07K
CHRIS/Proba Noise R.... [1.5.3 03-Aug-2011 2M
CHRIS[Proba TOARe...|1.5.3 03-Aug-2011 159K
\CHRIS/Proba Utlites  [1.5.3 03-Aug-2011 141K
ENVIProductReader [1.1.1 03-Aug-2011 22K
|EABAD Bron, Xy G113 i |
Module Information
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Billes to be instlle u"pdété

* Modules installation
* QAA AQP processor
e FUB WeW processor
* Modules update
e BEAM Graph Processing Framework (GPF)
e BEAM Processing Library
e MERIS Case-2 Regional Processor
e MERIS Lib Raiometry Processor
e NetCDF Product Reader and Writer
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1P Product - Metadata

=-&) [1] L2_of MER_FSG_1PNMAP20060629_105233_000002022049_00037_22636_0001

£ B iekis O Do e
" Value Type Unit  Desaription
) Global_Attributes ey e N N I
. ) variable_Attributes metadata srafie beam o
i H metadata_version 0.5 asi
i QMPH Conventions CF-1.4 asdi
i ¥ oSPH :::‘C::fmg rz;if“i.lfzumiw:sz:zq,ast;c»a: ::
: goso e S b fsdoneic coracion
| history
i ) Processing_Graph
@l Flag codings
-}y Tie-point grids
. Geometries
L. Bands
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Name.

o B node.0
) node. 1

i

. id Meris.ComrectRadiometry$ 13035897201 2=
operator Meris.CorrectRadiometry asal
~ purpose Performs radiometric corrections on MERIS L1b data... asGi
authors. Marc Bouvet (ESTEC); Marco Peters, Ralf Quast, Th... asal
version 10 asai
copyricht () 2011 by Brockmann Consult asai
=-& [1] L2_of_MER_FSG_1PNMAP20060629_105233_0I = nde.:
: N - - - - +-sourceProduct Product:MER_FSG_1PNMAP200609 18_151603_000... asai
248 Metadata |- doRadToRef false asdi
. |~doCalibration true asai
- Global_Attributes | dnsie 2 o
i ) = doEqualization true 2sai
@®- 0 Varlabie_Att’lbutes reproverson REPROCESSING_3 236
i &l node.2
H 0 MPH id CoastColour.L IP$13035BACA30 2sa
operator CoastColour.L1P asdi
@ seH o
& node.3
! o DSD id Subset§130426424€7 2sai
. operator Subset 2
0 hsmry purpose Create a spatial and/or spectral subset of a data pr... asci
n o authors Marco Zuehlke, Normen Fomferra, MarcoPeters  asal
o Processing_Graph s—— o 4 =
. i copyrioht () 2011 by Brockmann Consult asci
- |, Flag codings oo
. i i = node. 4
& ) Tie-point mds id Meris. GiniComection$ 13042642621 asdi
Geometries operator Meris.GintComection 2sci
« b purpase MERIS atmospheri correcton using a newralnet, 350l
#- L. Bands authors Marco Peters, Roland Doerffer, Olaf Danne asdl
x version 122 asai
copyright (c) 2008 by Brockmann Consult asi
Ernode.4
|- merisProduct productMER_FSG_IPNMAP20060918_151603_000... asci
outputPath e 2sai
useFiint false asa
outputTosa false asa
| outputAutoTosa false asal
deriveRwFromPath false: asci
doudlceExpression I1p_flags.CC_CLOUD [I11p_flags.CC_SNOW_ICE  asai
- atmotietMerisFie 20x25x45_55990. L.net asdi
outputRefiec rue 2=
LandExpression I1p_flags.CC_LAND asci
|-outputTransmittance false asai
| -atmoNetFlintFie 25x%30%40_6936.3.net asal
3 -outputRefiechs RADIANCE_REFLECTANCES sl
CoastColour UCMS3 * Lishk - dosmieCorrecton false *ci
! frue 256

oastcolou

1P Product
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/_\ -
& [1] L2_of L2_of MER_FSG_1PNMAP20060514_095740_000002332047_00380_21977_00!
(-} Metadata
G}y Flag codings
J. Tie-point grids
=} J. Bands

--[F] altitude
- | reflec
-}y norm_refl
[+~ 1y atm_tau
} ang_443_865
detector_index
I1_fiags
[ I1p_flags
-[3 1zr_flags
lat
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=& [1]L2_of 12 _of L 2_of MER_FSG_1PNMAP20060918_151603_000000872051_00197_23798_0001
i . Metadata

| Flag codings
|, Tie-point grids
. Geometries
%)

0® & 88

Naming translation
e 1= BER S]]
e [2 of 15 of MER... 2 CCI3R
e [2 of L2 of L2 of MER = CCL2W
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“Products for the Exercises

® CC Products

e .../products/LiP/
L2_of MER_FSG_1PNMAP20060918_151603_000000872051_00197_23798_0001.NC

e .../products/L2R/
L2 _of L2_of MER_FSG_1PNMAP20060918_151603_000000872051_00197_23798_0001.nC

e .../products/L2W/
L2_of L2_of L2 of MER _FSG_1PNMAP20060918 151603_000000872051_00197_23798_0001.nc

e .../products/L2W/pixelexport/

L2_of L2_of L2_of MER_FSG_1PNMAP20060510_153312_000001012047_00326_21923_0001.nC
L2_of L2_of L2_of MER_FSG_1PNMAP20060513_153832_000001012047_00369_21966_0001.nc
L2_of L2_of L2_of MER_FSG_1PNMAP20060516_154431_000001042047_00412_22009_0001.NC
L2_of L2_of L2_of MER_FSG_1PNMAP20060520_151941_000000332047_00469_22066_0001.nc
L2_of L2_of L2_of MER_FSG_1PNMAP20060522_155634_000000612047_00498_22095_0001.nC
L2_of L2_of L2_of MER_FSG_1PNMAP20060523_152401_000000282048_00011_22109_0001.nC
L2_of L2_of L2_of MER_FSG_1PNMAP20060529_153519_000001322048_00097_22195_0001.NC
L2_of L2_of L2_of MER_FSG_1PNMAP20060601_154102_000001072048_00140_22238_0001.n¢
L2_of L2_of L2_of MER_FSG_1PNMAP20060604_154646_000001042048_00183_22281_0001.nc
L2_of L2_of L2_of MER_FSG_1PNMAP20060605_151720_000000162048_00197_22295_0001.nC

laterial for the Exercises

¢ Pre-defined Pins
e ../pins/coord4stations.txt
e ../pins/in-situ_May2006_site6.placemark

® Pre-defined Colour Palettes
e ../colourpalettes/

* Pre-defined Colour Palettes in VISAT:
e (C:/Users/USERNAME/.beam/beam-ui/auxdata/color-palettes

o Slides

e ../material/
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BEAM

Toolbox for andlysis and processing of EO dafa

e - Craati

CoastColour UCM3 * Lisbon* 19.-21.10.2011

ISAT - Basic Imaging
e Basic Imaging Tools
¢ Colour manipulation

e Spectrum View
e Masks

CoastColour UCM3 * Lisbon* 19.-21.10.2011




I (1] L2_of_MER_FSG_IPNMAR20060918 151603 000000872051 00187 23798_0001 - [\Beam  of MER_FSG_3

. 151603 ¢ 00197 23798 0001.nc] - [Session not saved] - VISAT 4. L.l E

File Edit View Analysis Jools Window Help

Ra®@|i-B|s?

] detector_ndex

1 fags

Ready. Mo pos. 1915154 260M of 4310

@
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Display Bands

Open single bands
e Doubleclick on the band
Open RGB image
¢ Right mouse click on product name > Open RGB Image View..
e Menu: View = Open RGB Image View
¢ Choice of how to display
« Single band allocation to the RGB colours
» Combination of bands for the RGB colour

Profile: Profile:

MERISL2 - 13,5,1 MERIS L2 - Tristimuus = @iE
Red: |reflec_13 v | o) Red: |i0 * reflec_5 + reflec 6 + 0.13 * reflec_?) v [u)
Green: |reflec 5 hd _‘ Green: |i0 * reflec_4 + reflec S5 + 0.38 * reflec_6) ~ ‘
Blue: |reflec 1 - J Blue: |lec_2 + 0.47 * reflec 3 + 0.16 * reflec 4) = L,‘

Store RGB channels as virtual bands in current product

oc ][ concel |[ beb | 4 Cancel Help |

Store RGB channels as virtual bands in current product |




W VisaT 49

File Edt View Analysis Tools Window He v

S - y ccp & M & = * 0 p

Bald| g? 2 O UK WAaERZEZEOLTLLE
a 1] MERIS L b - Tristens RS x (i
P it | S [1] MERIS L1b - Tristimulus RGB e
Cooedinate Value Unit =1
‘ Imsge-. 502 el | ey
Image-Y 155 el 1 e
Longude RATITITE degree x| ol

A

Time Info, a el

Time vaive unk +
Date o date information_frryy-tm-00 N
Time (UTC) [No time information_ HH:HM:S5:mm (... | Py
Tie Point Grids a B

TiePoint Grid | Yalue unit @)
fattude Jes. 407645 | sl Y
lengtude [29.629675 [ 1

dem_sk 43200125 | EE
Bands

Band valve Unk

radance_{3 [100.851155 [ 2*sr*rm)
| 1i_flsgs 32 |

Y YY)

1] virtal_yed - Satelite coordinates
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8 1] radiance_13 - [*. Pl of_MER _FSG_] 151603, | 00197_23790001.nc] - [Session not saved] - VISAT 49 w2 ity

Fle fdt View Analysis Tooks Window Help

Ra@|EDle? Gk

2CB @Il HaEZEL£OZTALL P

B x

{1 Produe 1 &
W [11L2.of WER FSG_IPAHAP20060518 151603 0000008 - | (g 1] MERIS L - Tristimulu RGB B [1] radiance 13 -
4 |, Flag codngs . B =
& J Teportois @
& Bands
[ roionce_t
5 ey A
[ radiance_3 =i
[ redionce 4 N,
@ radiance s = |
(0] redience 6
i s 7
[0 rasiance 3 [ ]
[ radience 3
@ rodonce_0 @
[0 radiance_11 >
[ rasance_12 <:°}
e &
(0 radiance_15.
[ corr_latruce
O con_ongitde 34
astude =
(3 detector_index < = ccacicie
11_flags
0 1p_fegs | [@ror vame  Type Tr2.-: [ifanage binary data masks and R0k <) [
O - ] J1p_cc_land Maths % 0.5/Land fiag \*
4 F 0.5|Coastine flag :
! { ¢
° 0.5/Cloud flag e
0.5|Cloud buffer flag 0BG
Edtor: @ Siders () Table Discrete colors 0-5{cloud shadow flag r
0.5[5now/lce flag
sl o 2 0.5Potentilland pixel
Unit: mwj(m2*sr !
i & 0.5[Risk that pixel is under gint
Max: 232. 5% 100K '
Rough statistics! !:l Ir! O[Pixel is part of & coastine
CHC 0.75/pixel is over land, not ocean
@ 1 ib_water sths 0.75[pel 5 over ocesn, notlsnd
il e 1b_cosm... Maths 0.5Pixel is cosmetic
j, . A 5 , @ EXE i1b_dupk... Maths 0.5/Pixel has been dupbcated (Fled in)
= 2 2 H ] Jib_gint... Maths 0.5Pixel has ghnt risk
e |1b_suspect Maths 0.5pixel is suspect
2 More Options ? 1o brignt_Maths 0.5[pinel i bright
J1b_invaid aths Olpixel is invaid
m Lo ! t
- < - ] 2

[1] radiance _13 - Satelite coordmates
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ags

e L1P Flags
» Improved land/water
mask, coastline
» Improved Cloud flag
+ Cloud Buffer
+ Cloud Shadow
e L2R Flags
« atc_oor, toa_oor, tosa_oor
 Sunglint, l2r_invalid
e L2W Flags
« wlr_oor, conc_oor
o Law_invalid

¢ Flags for all 3 CC Product levels

2w _cc_wir_ootr Maths B o... 0.5[[vater le
I2w_cc_conc_ootr Maths . 4. 0.5([Vater cc
J2w_cc_cotr Maths [ 25... 0.5/Fpectrun
l2w_cc_whitecaps Maths 1 25... 0.5Risk for v

] l2w_cc_invalid Maths .. 0ljrvaid p
I1p_ce_land Maths B 19... 0.5|§and fiac
I1p_cc_coastine IMaths .[:l .. 0/|Foastline
I1p_cc_doud Maths | 25... 0/fioud fia
I1p_cc_doud_spatisl  Maths | 17...| 0.5|fpatalC
lip_cc_doud_buffer Maths I .. 0.5|floud bu
11p_cc_doud_shadow Maths . o.... 0.5|floud sh
I1p_cc_snow_ice Maths [ o... 0.5|Fnow/lce
l1p_cc_landrisk Maths ... 0.5 potential
l1p_cc_glintrisk Maths [125...] 0.5|fisk that
i2r_cc_ate_oor Maths [025..] 0.5]ktmosph

] I2r_cc_toa_oor Maths B 25..| 0.5]CAref
1 I2r_cc_tosa_oor Maths @ o,...| o.5[fosAre
J2r_cc_solzen Maths |1 25...| 0.5/fargeso
'Iz_:c_ancul IMaths .- 0s:s 0.5 |issing/C
2 _cc_sungint Maths  |[_125..| 0.5fighsun
7 I}s: gc_invalid Eﬂﬂs >- 0.5]Jnvalid p
[7] J1b_coastine Maths = 0/Pixel is p
I1b_land Maths Bl 5L..| 0.75Pixeliso
I1b_water Maths I 15...| 0.75pixeliso
l1b_cosmetic Maths B 20... 0.5/Pixel is &

CoastColour UCM3 * Lisbon* 19.-21.10.2011

I Manager - [7] iop_a_total_44
ﬂ ROl  Name Type Colour fx) [x]
) ] |l2w_cc_wir_ootr Maths o, -~ \Eh
] |l2w_cc_conc_ootr  Maths I 54 *
] ] li2w_cc_ootr Maths 2 5. Q] HJ
| l2w_cc_whitecaps ~ Maths [ 25. [FL Lm
| 2w _cc_invald Maths B 2. Y
) I1p_cc_land Maths ...
¥ ] lp_cc_coastine Maths I o.. |h W
| [ Jp_cc_doud Maths | ] 20, L
| £ J1p_cc_doud buffer Maths B & ﬁ
] 1p_cc_doud_shadow Maths .. o
] Jtp_ccsnowice  Maths B o. LN
lp_cclandrisc  Maths | O..
] |l1p_cc_glintrisk Maths [ 2s.
¥ ] Jlr_cc_atc_oor Maths I .
] |12r_cc_toa_oor Maths I .
] ll2r_cc_tosa_oor Maths B o,.
] ll2r_cc_solzen Maths = 2s.
I2r_cc_and Maths |
] Jl2r_cc_sunglint Maths [
[ & _ec_invalid Maths I 2.
. 7] |lib_coastine Maths I 0.
[ | |itb_land Maths | 51.
& 11b_water Maths | 15. ~ i
« n ’ ?

Coastcolour PM4b * Hamburg * 13.-14.07.2011
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e T e,

8 1] radiance_13 - [*. Pl of_MER _FSG_] 151603, 0019723798 00ggnc] - [Session not saved] - VISAT 49

Fle fdt View Analysis Tooks Window Help

La@|iRie? GuEaed @Il Wam
=] ’ Trstimus RGB (1] redence_13 | (1]

£O0ZTL22 8

L2_of MER_FSG_IPNMAP20060918_151603_0000008! -

8 [1] MERIS Lib - Tristimulus RGB B (1] radiance 13

808 Al

2
8

Y I

Masks
® pins
® ground_control_paints
V] @ I1p_cc land
7] ® I1p_cc_coastine
® I1p_cc_coud
® 11p_cc_doud_buffer
® 1p_cc_doud_shadow
® lip_cc_snow_ice
@ I1p_cc_landrisk
v
® 12r_cc_atc_oor
® l2r_cc_toa_oor
® 12 _cc_tosa_oor
® 12 _cc_solzen
® 1r_cc_andl
@ I2r_cc_sungiint
@ l2r_cc_invald

® I1b_coastine
| D

B,
212 & @)

@» 2]
L

~

[1] radiance _13 - Satelite coordmates

Transparency: ||
o o
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/mm View W

* Radiance / Reflectance spectra at cursor position or at
pins position

* Parallel display of several spectra (at pin positions)

* Export of spectra

¢ Selection of bands for display

0.015 v

B

2
<

7

< 0.0075 4 LA

o T T T T

100 500 600 700 800 200 o

Wavelength (nm) [

CoastColour UCM3 * Lisbon* 19.-21.10.2011
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nager

ager - (2] L 56 20060918_151603_0 0872051_00197_23798_0001

)?n = X Y Lon Lat Label radiance _1 radiance_2 radiance_3 radiance_4 radiance_5 radiance_&
S s e = I 7 O 7 I e
706.5 1203.5 -75.90677 36.886032 102 72.32145 62.5075 47.657936 42.99401 32.428787
741.5 1217.5 -75.81762 36.8326 103 71.932976 62.47569 47.808533 42.42661 31.159998
7%0.5 1205.5 -75.78317 36.85918 104 71.78138 62.019737 46.81228 41.323925 29.555351

« m

18.758991
17.506208
16.523634

1B

af [

| Display spectrum at the current

(mw/(m~2*sr*nm))
«
3
!

N
b
L

o T T

600 800
Wavelength (nm)

xercise |
* Open L1P and L2R products and display different bands:
e RGB image of LiP

e RGB images of L2R
e Reflectance band X

* Adjust colours for the RGBs and apply colour palette to the
single band 2

* Display LiP flags over the single (!) band using mask

&z

manager =:

¢ Note: flags in BEAM are working only on single band images, not on RGB. If you
want to add flags on the RGB, please use the layer manager Z

* Investigate where the flags are raised
* Look into the different spectra (TOA, water leaving etc) 1

 Add pins and allocate colours to the pins (spectra) using the
edit tool ([}f) in the pin manager

CoastColour UCM3 * Lisbon* 19.-21.10.2011
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¢ Subsetting
* Data Flip

* Attach/Detach Geo-Coding

¢ Re-projection

~Geo-Processing

=

e Orthorectification

® Collocation

* Mosaik processor

¢ L3-binning processor

CoastColour UCM3 * Lisbon* 19.-21.10.2011

Tools | Window Help

Create Band by Band Maths...
Create DEM-related Bands...

',; Create Geometry Container...
Detach Pixel Geo-Coding...

Data Flip...

Reprojection...

Ortherectification...

Mosaic...

Collgcation...

Level-3 Binning

Image Analysis

ELH/MCI Processor...

Case-2 Regicnal Processor (MERIS)...
Radiometry Correction (MERIS)...
Cloud Probability Processor (MERIS)...
'NDVI Processor (MERIS)...

SMAC Processor (MERIS/(A)ATSR)...
SST Processor ((A)ATSR)...

Glint Correction (MERIS/(A)ATSR)...

* Use Latitude and Longitude provided in bands

e Standard Lib: tie point grid

e CoastColour Products: additional lat lon bands derived

from AMORGOS correction

&= [2] L2_of MER_FSG_1PNMAP20060918_15160

- FRS 2> FSG & Metadata
e Bands are already attached o ek
- J, Tie-point grids
to the CC products - Bands |
- J, radiance
e If working with AMORGOS on LiB: [ i gt
. o 3 i
Geo-Coding must be attached 0 albtuce
before working with E .df_t;:;m‘mdex
Reprojection or Geolocation S
= [ lon

Tools

CoastColour UCM3 * Lisbon* 19.-21.10.2011
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eprojection Tool

File Help

Ij0 Pa;amewsl Reprojection Parameters

Coordinate Reference System (CRS)

Custom CRS

Geodetic datum: |World Gy
M Select Coordinate Reference Sy

Scene width: 0 pixel

Projection:
Filter: | Q, Well-Known Text (WKT):
@ Predefined CRS -
AUTO:42002 - WGS 84/ Auto Tr. Mercator
Use CRS of AUTO:42003 - WGS 84 / Auto Orthographic
AUTO:42004 - WGS 84 / Auto Equirectangulai
Output Settings EPSG:2000 - Anguila 1957 / British West Indie
EPSG:20004 - Pulkovo 1995 [ Gauss-Kruger zc
[¥] Preserve resolution EPSG: 20005 - Pulkovo 1995 | Gauss-Kruger z¢
EPSG: 20006 - Pulkovo 1995 / Gauss-Kruger z¢
ut Parametex EPSG:20007 - Pulkovo 1995 / Gauss-Kruger zc
EPSG:20008 - Pukovo 1995 [ Gauss-Kruger z¢
Add delta latfon bands EPSG:20009 - Pukovo 1995 / GaussKruger z
EPSG:2001 - Antigua 1943 / British West Indie _
Output Information T Sests m |

Scene height: 0 pixel [E | Cancel |
o No valid 'C c — = ——
" System' selected. =

/‘

8K

[3] virtual red - WGS84000)

Hopos:

[ visaT a3 (=] © o)
File Edit View Analysis Tools Window Help
Bad| g7 JBiE4S
[ Produe & 2 x
[0 detector_index “ 80 [3] MERIS L1b - Tristimulus RGB
1_fags 2
O 11p_flags
Dat @,
0 o
S8 1(5] L2_of MER_FSG_IPNMAP20060918_151603_0000 &
DL Metadats o
&
aop
=
\+
w7
[}
@
=3

08:35:40

4874 of 00

o
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ollocation Tool

* Combine 2 products in one grid (of master product)

e the base grid can be
« aprojected grid
« the original grid of the master product
e all bands are combined in one product

* Enables the combined analysis of several products
* Band arithmetics
e Scatter plots
* Overlays

CoastColour UCM3 * Lisbon* 19.-21.10.2011

s
M Collocation % ti rﬁ”m‘:
_radiance ¢
File Help [0 L1P_radiance_7
[ L1P_radiance_8
fﬁﬁm [0 L1P_radiance_s
3 3 [ L1P_radiance_10
Master (pixgf values are conserved): § [ L1P_radiance_11
L2 _of MER_FSG_IPNMAP20060918_151603_000000872051_00197_23... w J E [ L1P_radiance_12
eDabses are resampled onto the master grid): % g
| [1]L2_0f L2_of 12_of MER_FSG_1PNM 151603, e [ L1p radance 15
O L1P_corr _latitude
Target Product [0 L1P_corr _longitude
Name: [ L1p_slttude
: [0 L1P_detector_index
combined_L1P_L2W [d LiP_11_flags
E— 3 LiP_J1p_f
BEAM DIMAP % LLP_I.:‘: s
o - [ LiP_ton
ecto [ L2w_corr_latitude
C:\Users\KerstinS [ L2w_corr_longitude
Open in VISAT % t;,”\f":‘:‘;';'d,;?j
[ L2w_iop_a_pig_243

Renaming of Source Product Components [ L2w_jop_bb_spm_443
Rename master DINAL_NAME L 2w conc_tsm
¥l mas| mrvonen _NAME} [ L2w_conc_chi
e A [ L2w_chisquare
Rename slave cunpoﬂmts IAL_NAME} @ L2w_K_min

@ L2w_kd_412
Resampling [ 12w _xd_443

Method: | Nearest neighbour resampiing. | @ L2w_kd_490

@ L2w_kd_s10

Ce=J e

[0 L2w_kd_ss4

[ L2w_kd_s80
CoastColour UCM3 * Lisbon* 19.-21.10.2011 3 2w zs0.max

10w bahidite o
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Band Méth

* Band Math Tool is used to
arithmetic expression

possible if they are on the

product to the other

¢ Combination of bands from different products

» Use Band Math Tool for copylng bands from one

add new bands by using

same grid

i L2 of L2 of L2 of MER FSG, ].PMAPEDSDQJB 151603 000000872051 _00197_23798 0001 +
Name: new_band_4

Description:
Unit:

Spectral wavelength: 0.0

[¥] virtual (save expression only, don't write data)
7] Replace Nah and infinity results by

Band maths expression:

Lo ] [ ) [0 )

CoastColour UCM3 * L|
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Mask/ROI Concept

*  Masks are used for masking image pixels
e Masks for display: MASK
e Masks for analysis: ROI

Tool for organising Masks and ROIS:
Mask/ROI manager

Flags are handled as masks

BEAM Training * Oslo * 17.02.2011

Definitions
* Geometry

A geometric shape (point, line, polyline or polygon).
Geometries can be drawn on a scene view.

* Mask

» Masks a regions of raster dataset. Masks can be derived
from an expressions, a value range or a geometry.

* ROI

e A ROl is a role of a Mask. Masks can be assigned to a
band, so they can be used as a ROI. Statistical
computation can be performed on a ROI.

18



* Elements
« Geometries
« Masks
» Bands
¢ Functions
Visibility

 Transparency

o Re-order

» Add new layers
» Zoom to layers

* Add new layers/overlays

+ Shapefiles
« Bands
« Images

ayer Manager

(=

E - [¥] 3 Geometries
@ pins
@ ground_control_points
.
=[] 9 Masks
pins
ground_control_points
12_land
cloud_ice
ancil
solzen
satzen
whitecaps
rad_err
tosa_oor
wir_oor
ootr
12_invalid
ate_oor
conc_oor
sunglint
fitFailed
spareflagDé
spareflagl?
geometry_Line
1b_tsm

<

HO0000000000D0000O000d

CTevsevsescsssceesssreces

*

Transparency: ]
0% 50%

&

100%

d

+ &> oY

L.° )
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/’m Masks

* Generation of Masks

ft9 o Masks defined by a band maths expression

1« Masks defined by a value range

&% ¢ Masks defined by a geometry such as lines and polygons

* Combination of Masks
9 o Union

E.U * Intersection

4 Differences

B e Complement of Union

BEAM Training * Oslo *
17.02.2011

I (3] conc_chi - [*_\Products\L2.of R_FSG_1PNMAP20060918,151603_000000872051_00167_23798_ 000 dirn] - [Session not saved] - VISAT 49 1

View Analysis Help

| Ra@E|EDle? GBRELSE OwIll WaEZSEAL D

* | TH3] conc_chl

on
5 @ [3)L2.07 L2_0f 12 of MER_FSG_IMMAR20060928_ e
8 Metadal

®
-l B
ZE

- i Flag codgs
® i Tie-pont grids

e
|@|ro1  Name
Geonetries L \ " 1 I1p_cc_snow_ice
h geometry._chesapeak ' | [ Jip_sc_jandrisk
Bands b
[] l1p_cc_ghntrisk
0 cor_ongitude ¥ = ] I2r_cc_ate_oor
: [ l2r_cc_toa_oor

feng

FOQI</ /505 Pl

280
if
WG

=
3

BPOeR O&

ArEFdOPY

g
1
e

il oopeon
seg
3

= [
@ i I1b_glint_risk
d b 7 l1b_suspect

B = I1b_bright
@ ey I1b_invaiid s

fgeometry_chesapeak Geometry | 25 -
28 o
i

20



M (3] conc chi -

im) - [Session not saved] - VISAT 49

File Edit View Anslysis Tools Window Help

Ba@EI|E-Rlg? 4

5 4%® @0z~

amE£0LAL

- Ju Flag codngs
® s Tiepant grids

Geometres
i geometry_chesapeak
Bands
0 cor_avee
3 cor_ongitute

o

nc
@ conctsn

Max:
Rough statitis

3] conc_chi - Satelite coordinates

B=®

@w el

PLliend

3 3] cone_chl.

16:17:56

Tre... Desapl
0.5Risk for 1 o
0 Tnvaid
0.5Land fiag
0.5 Coastine
0.2Coud Fio
0.5,Coud bu
0.5Coud
0.5/50omlc
0.5 potentel
0.5 Risk that
0.5Atmasph
0.57T0A Al
0.5T08A e
0.5Large so
0.5Mssngh =
0.2igh aun
0.5[waldp
opuelsp
0.75Pel 0
0.75pslis 0
0.5pwelis o
0.5ixel hae
0.5 pixel e
0.5pelis s
0.5pxelsb

QFuelsr

S0 of T3ab

t4d

o

L PR

=]

8 (3) conc_chi - [".\Product:\L2 of L2 of L2 of MER_FSG_LPNMAP20060918 151603 000000872051 00197 23798 0001.dim - [Session not saved] - VISAT 49

@

Ras[EI|5 B
)

le Edit View Analysic Tools Window

57 G

Help.

48 @Il WAaRZEZ£ETALL P

¥ Flag codings:

i Te-pant grids

Geometries

i geometry_chesapeak
Bands

[ cor_latitde
0 conongide

Discrete colors

Max: 41.895
Rough statistics!

& More Options:

@Y LliFv

lie 8

gwe

8 3] cone_chl

ftx) [x]

T
0.75pxel s 0|
0.75pelis 0

0.5Poel 5 1
0.5poxel hos
0.50pieel has
0.5pelis 51
0.5Pelisb)
Opeiis

FH9BY
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~Analysis Tools

¢ Information

¢ Band specific meta information

Geocoding

e of the product
Statistics

¢ of whole band or ROI
Histograms

¢ of whole band or ROI
Scatterplots

¢ of whole band or ROI
Profile plots

¢ of geometries
Coordinate list

e of geometries

[—

e oo, e st | e o
Histogram for conc_chl

’/-1,7/'

* Apply as ROI

-

xercise 2

* Produce a mask that contains all valid TSM pixels
inside of the Chesapeak bay

¢ Display statistics, scatterplots, histograms for the ROI
with and without invalid flag set on inside of the Bay

* Draw TSM values along a transect

CoastColour UCM3 * Lisbon* 19.-21.10.2011




¢ Saving as BEAM DIMAP Format

¢ Name can be only changed in properties of product

- File > Save as.. -

* Exporting displayed images

e div. Image formats (geoTIFF, TIFF, png, jpg, etc.)
e Export of subsets and full images possible s
- Right mouse click in the displayed image
@
* Exporting of colour palettes -

e as images - Right mouse click in the displayed image
e as xml file > choose export button in colour manipulation dialog

* Exporting of pixel values
- Right mouse click in the displayed image

How to get the information out of VISAT

Right mouse click in
displayed image:

Copy Pixel-Info to Clipboard

Show ROT Overlay

Show Graticule Overlay
Band Arthmetic...

3 show GCP Overlay

Export Displayed Image...
Export Colour Legend...
Show No-Data Overlay
Export Google Earth KMZ...

Export Colour Palette. ..

% Show Pin Overlay

Create Subset from View...

alysis  Tools Window

5 New Product Strg+N
S Open Product... Strg+0

Open Session... Strg+Umschalt+O
Reopen »
&  Product Grabber Strg+Umschalt+P

Close Product Strg+W

Close Session Strg+Umschalt+W
Save Product Strg+S
@ SaveProduct As...

Save Session Strg+Umschalt+S
& Import »
i Export *] Export Geo-Coding as ENVI GCP File...

Export Colour Palette as File...

Export HDF5 Product...
Export GeoTIFF Product...
Export Mask Pixels...

Export BEAM-DIMAP Product...
Export NetCDF/CF Product...
Export Pixels...

Export NetCDF/BEAM Product...
Export View as Google Earth KMZ...
Export View as Image...

Export Colour Legend as Image...

CoastColour UCM3 * Lisbon* 19.-21.10.2011
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oastcolou

Coordnates: Name  Latitude Longit.. DateTime (UTC) +
101 36.9139) -75.9424) Al
102 3%.8872_-75.9079) iS5
103 36.8326| -75.8174 =i
104 36.8599) 75.7844|
105 3.969 760193
106 36.9008| -75.5092) -

14 1x1
Edit Expression...
Note: The expression might not be applicable to all products.
Use expression as filter (@) Export expression result
Sub-scenes: [] Enable export Border size: 0

KMZ coordinates: ] Export found coordinates in Google KMZ format

CoastColour UCM3 * Lisbon* 19.-21.10.2011

oastcolou

(L ——
alidation exercise

1] pixEx MER FSG_CCLIW. measurements.tr - Editor (=)
DoteiBearbeiten Format _Ansicht 2 ]
[ BEav pixel extraction export table B
# window size: 1
# Created on:  2011-10-20 16:02:11 |
¥ wavelngth: 0.0 0.0 0.0 0.0 0.0 00
prodio [coordro name  Laticude Longitude pixelx Pixely D Ti ) corr_latitude |
0 1 67 73 sty 892.500 1144.500 006-05-10 15:34:03 36. 588335907724
0 2 6 -75.516007 905. 500 1166. 500 2006-05-10 15:34:04 36. 483068007 88683 |
0 3 72 -7‘.163051 6. |
0 s 106 E 889. 500 1146.500 2006-05 36. 54507190773 |
0 5 107 906. 500 1167.500 2006-05- 36.48075390783495 |

[0 & & 8821500 1153500 2006-05- 36. 3649629081, ‘.
1 1 & 900. 500 1599. 500 2006-05- 36.547059907727544 i =
1 H & 913, 500 1620. 500 2006-05- 36, 485019907 88418 5. 51662880933884 |

I& 3 7 1258, 500, 1524. 500 S8 s se061685. ~74.46237681201
1 4 106 897,500 1601. 500 2006-05- 36.544006907735025 -75. s44seradonears
1 s 107 914500 1621. 500 2006-05- 36.48171690789252 75. 5143008093447

1 8 B 950500 1643. 500 200605 36.363540908190885 5.3254568008215
2 1 &: 808. 300 1159. 500 2006-05- 16:349027907722575 5. 5341498092946
2 H & $211500 118150 2006-05- 3. 5.51813980933503

(2 3 7 1079. 500 e, $13134907813146 74.4633698119,
2 4 106 355500 1162, 500 2006-05- 36.54309390773756 - 9

I H 107 $22:500 1182500 2006-05- 36.48030450780386

|
3 1 & 740.500 235. 500 2006-05-20 s-vnaaonzsss —?s 533’5980?29556

(3 H 6 752,500 257500 2006-03-20 84526007885424
3 3 72 36. 512431907814 263355511998
3 s 106 7367300 237. 500 2006.08-20 53420290773476 75. 5443528092688 0.0809:

(3 5 107 753,500 258,500 2006-05-20 48137690780338 -75.513795809345 0.0707"
3 & B 8270500 289.500 2006-05-20 09081852 -75.32240780982215

i it 6. 3504 8940500 2064.500 2006-05- 36.54737790772674 -75.53504180920235

n z & -75.516350 907, 500 2085. 500 2006-05- 36.485140907883874 -75.51634980933954
4 3 7 -7ala62143 1254500, 1990. 500 36 s1332700781271 -74.46214381200

(4 4 106 -75.545075 891.500 2066. 500 2006-05- 36. 5442529077346 -75.5459748092647 5

- s 07 -75.514145 908. 500 2086. 500 2006-05- 18 iissisoraanoss -75.51414080934512

e
) pixe productidMap.txt - Editor [ESEE=)
Datei_Bearbeiten Fgmn Ansicht 2
1D May =

produc§In Perogucrrype ProductLocation

o S6.CCL2W Tt \users\xersc(ns\mumen‘:s\uc\eovata\:nastco our L2wie2_of L2_of L2 _of MER_FSG_1PHM.
1 MER_FSG_CCL2W  C:\Users'\KerstinsS\Documents\BC\EOData\CoastColour 'y 2wh\L2_of _L2_of _L2_of MER_FSG_1PNM.
2 MER_FSG_CCL2W  C: \llsers\»(erst(ns\no:umen:s\Bc\Eunar.a\cnast(a our 2w\L2_of _12_of L2 of MER_FSG_1PNM.
3 MER_FSG_CCL2W  C:\Users\Kerstins\Documents\BC\EOData\CoastColour ZW\L20f L2 70T L2 0T MER_FSG_1PH
4 MER_FSG_CCL2W  C:\Users\Kerstins\Documents\EC\EoData\Coastcolour 2W\L2 of L2 of L2 of MER_FSG_1PNM,

5 MER_FSG_CCL, C:\Users\Kerstins'\Documents\BC\EOData\CoastColour 2W\L2_of L2 afJ.Z uusLFsc_wm.
8 MER_FSG_CCL2W  C:\Users'\Kerstins\Documents\BC\EODATa\CoastColour 2WAL of _MER_FSG_1PNM
| :
‘ i ] v
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ime series plot

HELGO
35
30 +
25
20 - +
@ CHL MERIS daily
15 -+
+* | insitu
*
10 1 +
. * .I * *
5 e d *——f*
+*e * * *
ote t *, 9/‘ *
[Lpua— |
= w ~ ™ N w w w ~ "~ N ~ ~
P B2 ¥ & = 2 2 5 5 B B8 2 &
8 & ® & §F § E & § 8 § £
CoastColour UCM3 * Lisbon* 19.-21.10.2011
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/_\7 oo
xercise 3: Pixel Extraction

* Extract the pixels from May Products
o .../products/L2W/pixelexport/
+ Add product folder to as input

¢ Investigate tables in Excel

CoastColour UCM3 * Lisbon* 19.-21.10.2011
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PT — Graph Processing Tool

* GPT is used to execute BEAM raster data operators in
batch-mode

¢ used stand-alone or combined as a directed acyclic
graph (DAG)

* Processing graphs are represented using XML

CoastColour UCM3 * Lisbon* 19.-21.10.2011

= . e e ——
— B CAWindows\system3Zicmd exe _—
oastcolour Pescription:

This tool is used to execute BEAM raster data operators in hatch-node. The
operators can be used stand-alone ov combined a & directed acyelic sraph

AC). Processing graphs are represonted using AML. Mowe info abou
processing graphs, the operator API, and the graph XML format can be found
%n the BEANM docunentation-

Arguments:
<o Name of an eperator. See below for the list of <opds.
Operator graph File CKHL £ornat).
<i>th source product file. The actual number of source
file argunents is specified by <op>. May be optional for
operators which use the -8 option

-
Sgraph—file>
<source—file-i>

ptions:
~h Displays comnand usage. If <op> is given. the specific
operator usage is displayed.
-e Displays more detailed error messages. Displays a stack
trace. if an exception occurs.
<File> The target File. Default value is ’./target.din’.
{Format> Output file format, e.g. ’Ge S IT
*BEAM-DIMAP’ . If not specified, Format will be derived
van the target filename extension. if any. otherwise the
default Format is ’BEAM-DIMAP’. Ony used. if the
in <graph-file> does not specify its own ’Urite’ operator.

-p <file> A <Java Properties) File containing processing
parameters in the Form <name>=<value’ or a KML file
containing a a parameter DOM For the operator. Entries in this
le are overwritten hy the —P<nane>=<valus) command-line
option (see helow

-0 Ccache-size>  Sets the tile cachs size in Bytes. Ualus can be suffixad I\
ith and "G’ Hust be less than maxinum
eq1ants hzap space. I equal to or less than zero. tile

caching will be cnmplstzly iabled: The defauls cile

cache size is ’512M

-q <parallelism> Sets the maximun parallelisn used for the computation, i.e.
the maxinun nunber of parallel (native) threads.

The default parallelism is

-x e i o renrat rte saihe afteriu ng a complete
rou of_tiles to the targat product File. This optisn may
bhe useful if you run into memory problems.

~T<target>=(File> Defines a target product. Ualid For graphs only. <target>
nust be the identifier of a node in the graph. The node’s
output will he written to <file>.

-8<source>=(File> Defines a souwrce product. {source> is specified by the
operator or the graph. In an XML graph. all occurrences of
${<source>} will be replaced with references to a source
product located at <File>.

-P{name>=¢value> Defines a processing parameter, <name> is specific For the
used operator or graph. In an %ML graph. all occurrences of
$<¢<name>> will he replaced with <value>. Overurites

I

parameter values specified by the ’-p’ option.
perators:
BandHaths reate a product with one or more bands using mathematical expressions.
ClearLandFilter ilters input to be both clear and over land
Collocate ollocates two products hased on their geo-codings.
EHClusterfnalysis Perforns an expectation-maximization CEM) cluster analysis.
ExpectedDisparities onputes expected disparities from elevation

InageCoregistrat ion
KHeansClusterfinalysis

ternines nadir/foruard coregistration by deternining shift for clear views of land
erforns a K-Heans cluster analysis.

M4StereoMatcher tereo matches using M4 Algorit

M5StereoMatcher tereo matches using M5 Algorithm

Hanns te inCaneratiods 1 cometric height From parallax using Mannstein Camera Model

oris . onpute the BRR of a HERIS Lib product.

He Casnzkei Ferforns [0F rotrioval on Lib MERIS praducts. including atmospheric correction
Tonts Comotehaaionetry erforns radionctric corrections on HERIS Lib data produ

Meris .GlintCorrection ERIS atnospheric corvection using a neural not

Meris . Lakes Perforns [0F retricval for eutrophic and horeal Lakes on Lib MERIS products, includin
atmospheric correction.

Heris .NiPatcher Copies an existing Nt file and replaces the data for the radiance hands

Meris :gaal OF GAA For I
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B C:\Windows\system32\cmd.exe | - - - -

Operators :
BandMaths
ClearLandFilter
Collocate
EMClusterfAnalysis
ExpectedDisparities
InageCoregistration
KMeansClusterfAnalysis
M4StereoMatcher
H5StereoMatcher
HannsteinCaneraModel
Heris.
Meris.Case2Regional
Meris. Cnrrectg
Heris.GlintCorrection
Heris.Lakes

atmospheric correction.
Meris. Nantcher
Heris.Qaalo!
Mosaic
Normaliser
PixEx
Read
Reproject
Subset
SunElevationDataFilter
nmix

i Write

| glint.Flint
icol.Meris
icol.Themat icMapper

adionetry

Create a product with one or more bands using mathematical expressions.

Filters input to he hoth clear and over lan
Collocates two products based on their geo—codings.

Performs an expectation-maximization (EM> cluster analysis.

Computes expected disparities from elevation

Determines nadir/forward coregistration by deternining shift for clear views of land

Performs a K-Means cluster analysis.
Stereo matches using M4 Algorithm
Stereo matches using M5 Algorithm

Computes geometric height from parallax using Mannstein Camera Model

Compute the BRR of a l‘IERIS Lib product.

Performs IOP retrieval on Lib MERIS products, includin
Performs radiometric corrections on MERIS Llh data pro:

MERIS atmospheric correction using a neural n

Performs I0P retrieval for eutrophic and ho»eal Lakes on Libh MERIS products,

g atnospheric correction.
u

cts.

plES an existing N1 file and replaces the data for the radiance bands

Qﬁﬂ fo

Cv-eates a mosaic out of a set of source products.
Normalises an_input image

Extracts pixels F

Reads a product from disk.

rom given lecations and source products.

Reprojection of a source product to a target Coordinate Reference System.
Create a spatial and/or spectral subset of a data product.

Filters input data based on sun elevation
Performs a linear spectral unmixing.
Writes a data product to a file.

Flint Processor.

Performs a correction of the adjacency effect for MERIS Lib dat
Performs a correction of the adjacency effect for LANDSAT TH le data.

recalibrateAATSRRef lectances Recalibrate AATSR Ref lectances.

ineludi

| c:\Program Files\bean-4.9.8.1 haseN\bin>
\Program Files\bean—4.9.8.1_bhase\hin>
<
E—

I,

CoastColour UCM3 * Lisbon* 19.-21.10.2011
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[ Welcome to BEAM - brackmann-consul... | +

3 | [B v brockmann-consuhde/crns/web/beam
il B | o roctmann-<onsuktde/ o/ websar

aligemein | BC | BEAM || Projects ||

@

Downloads
¢ Software
* Sample Data

Community
e Forum
* Wiki
o Issues
¢ Code Base

Documentation
* Online Help
¢ Javadoc
* Tutorials
« FAQ

Screenshots

The European Space
Agency is making
BEAM available free of
charge to the user
community

]
| BEAMHome

BEAM

° =TE
-
)
o Fahrrader | | Kerstin | Satelltes | Mobel I Lesezsichen
Qi N | CDIEEITIE) (- Crecte POF [] FositMessages - [ Fost Online Sevices () Products - , optionen - ] -

Earth Observation Toolbox and Development Platform

The BERM Brojeet

BEAM is an open-source toolbox and development platform for viewing,
analysing and processing of remote sensing raster data. Originally developed to
facilitate the utilisation of image data from Envisat's optical instruments, BEAM
now supports a growing number of other raster data formats such as GeoTIFF
and NetCDF as well as data formats of other EQ sensors such as MODIS,
AVHRR, AVNIR, PRISM and CHRIS/Proba. Various data and algorithms are
supported by dedicated extension plug-ins.

Software Components

& VISAT - An intuitive desktop application to be used for visualization,
analyzing and processing of remote sensing raster data. To get an
impression of how VISAT looks and feels like, please take a look at the
related screenshots page.

* A set of scientific tools running either from the command line or invoked by
VISAT, also entirely written in Java.

* Arich Java API for the development of new remote sensing applications
and BEAM extension plug-ins.

Supported Instruments

« BEAM is mentor at
ESA SOCIS: Apply
now!
20.Jul 2011, 14:54

“ BEAM 4.9 available

12. May 2011, 22:30

4+ SMOS-Box 2.1.1

released
03. Dec 2010, 13:30

~ SeaDAS 7 frontend
will build on BEAM rich
client platform

28, Oct 2010, 08:53

“+ New MERIS L1

processor and

updates for BEAM 4.8

16. Sep 2010, 09:40

more...

| Latest Forum Posts

Get your own account
and Sign In to post in the
o
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* kerstin.stelzer@brockmann-consult.de

* marco.peters@brockmann-consult.de

http://www.brockmann-
consult.de/cms/web/beam/forum

CoastColour UCM3 * Lisbon* 19.-21.10.2011
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